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1. ÚVOD 
Velkou část z času stráveného při zpracovávání energetických výpočtů staveb tvoří odečet ploch a objemů. 

Klasický postup pomocí "ručního" odečítání ploch s sebou přináší řadu rizik. Využití nástrojů pro tvorbu 3D 

modelů (například SketchUp) přináší řadu výhod: 

- vizuální kontrola 

- omezení rizika početní chyby 

- snadná orientace v případě změn 

- snadné provedení úprav 

- zachovalý a pochopitelný model pro další generace 

Tento manuál poskytuje základní informace o tom, jakým způsobem odečíst plochy a objemy pomocí 3D 

modelu vytvořeného v programu SketchUp. 

2. O PROGRAMU SKETCHUP 

2.1. HISTORIE 

Následující text byl převzat z Wikipedie
1
. 

SketchUp byl vyvinut začínající společností @Last Software v Boulderu v státu Colorado, Bradem Schellem 

a Joem Eschem v roce 1999. První verze SketchUp byla uvedena na trh v srpnu 2000, byl představen jako 

snadno použitelný 3D nástroj určený pro tvorbu 3D modelu s jednoduchým uživatelským rozhraním. SketchUp 

byl prezentován jako softwarový program, který designérovi umožňuje pracovat stejně jako při práci s perem 

a papírem. To vše s jednoduchým a elegantním rozhraním, jehož použití je zábavné a snadno pochopitelné. 

SketchUp poskytuje návrháři celou řadu funkcí, díky nimž si může hrát se svými návrhy, tak jak to v ostatních 

softwarech podobného zaměření nebylo dosud možné. 

Již na své první předváděcí akci v roce 2000 program vyhrál Community Choice Award. Klíčem k tak brzkému 

úspěchu byla kratší učební doba oproti jiným 3D nástrojům. 

14. března 2006 Google kupuje @Last Software a veškerá práce této společnosti je dále vyvíjena jako plug-in 

pro Google Earth. 

V lednu 2007 byl na trh uveden program SketchUp 6, jehož součástí byly i nové nástroje se shodným 

rozvržením jako v beta verzi Google SketchUp. Nové rozvržení v sobě zahrnovalo 2D vektorové nástroje, stejně 

tak i stránkovací nástroje, což umožnilo profesionálům vytvořit prezentaci bez použití jiných programů. Další 

vlastnosti, které byly přidány, sloužily k tomu, aby uživatel mohl ořezávat a rozšiřovat modelovaný objekt nebo 

upravovat jeho okolí. 

17. února 2007 byla vydána sada aktualizací opravující řadu chyb, ale nepřinesla žádné vylepšující funkce. 

17. listopadu 2008 byla uvedena na trh již 7 verze tohoto programu, která s sebou přinesla integrovaný 

SketchUp prohlížeč s Google 3D Warehouse, LayOut 2, dynamické komponenty reagující na změnu měřítka, 

zvýšený výkon Ruby API. A byla odstraněna podpora pro Windows 2000. 

1. září 2010 spatřila světlo světa 8 verze programu. SketchUp 8 umožňuje georeferencovat vytvořený model 

pomocí Google Maps, importovat barevné a přesnější snímky terénu a přináší integraci Google Building Maker, 

                                                                 
1
 SketchUp – Wikipedie. Wikipedie: Otevřená encyklopedie. [online]. 2001- [cit. 2014-06-09]. Dostupné 

z: http://cs.wikipedia.org/wiki/SketchUp 
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díky níž může uživatel načrtnout budovy a následně je uložit do Warehouse. V této verzi se též poprvé objevily 

miniaturní zmenšeniny obrázků. Podpora pro Mac OS X Tiger byla v této verzi vypuštěna. 

26. června 2012 byla koupena společností Trimble Navigation. 

2.2. ODKAZY KE STAŽENÍ 

Instalační soubor programu SketchUp lze stáhnout na http://www.sketchup.com/download/all. 

České prostředí pro program SketchUp lze stáhnout na http://www.radekryznar.cz/ke-stazeni-program-

sketchup-ceske-prostredi-a-rozrireni/. 

UPOZORNĚNÍ: Poslední volně dostupnou verzí, které je možno používat pro komerční účely je verze 8.  

U vyšších verzí je pro komerční účely potřeba zakoupit licenci verze Pro. 

2.3. ZDROJE INFORMACÍ 

Tento manuál se nezabývá popisem základů práce v programu SketchUp, pro osvojení si základů užívání 

programu je k dispozici velké množství on-line výukových materiálů. 

Návody pro práci s programem naleznete na následujících stránkách: 

V angličtině: http://www.sketchup.com/learn. 

V češtině: http://onlinesketchup.cz/ucime-se-sketchup/. 

  

http://www.sketchup.com/download/all
http://www.radekryznar.cz/ke-stazeni-program-sketchup-ceske-prostredi-a-rozrireni/
http://www.radekryznar.cz/ke-stazeni-program-sketchup-ceske-prostredi-a-rozrireni/
http://www.sketchup.com/learn
http://onlinesketchup.cz/ucime-se-sketchup/
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3. ZÁKLADNÍ FUNKCE PRO VYTVOŘENÍ MODELU 
Program SketchUp nabízí rozsáhlé možnosti tvorby 3D objektů. Cílem tohoto manuálu není popsání všech 

funkcí, které je možno v programu využít. Představeny budou pouze základní  funkce, které jsou potřebné 

k vytvoření modelu a odečtení ploch pro potřeby následného použití v aplikaci Energetika. 

3.1. PRACOVNÍ PROSTOR 

 

3.2. NASTAVENÍ MĚŘÍTKA VÝKRESU 

Nastavení měřítka výkresu lze provést výběrem šablony (Template) při spuštění programu, nebo lze jeho 

nastavení kdykoliv změnit pomocí menu Window -> Model Info. 

 

  

Kontextové menu Panely nástrojů 

Hlavní pracovní prostor 

Okno řídících hodnot Stavový řádek 

Nitkový kříž  

(počátek souřadného systému) 

Výběr měřítka kreslení 
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3.3. PANELY NÁSTROJŮ 

Po prvním spuštění programu máte k dispozici panel nástrojů s názvem Getting started, který obsahuje všechny 

základní funkce. Pro potřeby odečtu ploch budeme potřebovat zobrazit navíc pouze panel Layers pomocí menu 

View -> Toolbars -> Layers. 

 

 

 

  

Výběr panelu Layers 

Panel Layers. 

Přetažením lze připnout k ostatním panelům. 
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3.4. ZÁKLADNÍ FUNKCE 

Funkce Ikona 
Klávesová 

zkratka 
Popis 

Select 
(Výběr)  

Mezerník 

 

Slouží pro výběr jednotlivých prvků, celé skupiny nebo 
komponenty. 
Kombinace s klávesami: 
+ Ctrl -> přidá prvek do výběru 
+ Shift -> přidá/odebere prvek z výběru 
+ Shift + Ctrl -> odebere prvek z výběru 

Line 
(Čára)   

Slouží pro kreslení rovných čar. Pokud je vytvořen v rovině 
uzavřený tvar, automaticky se vytvoří plocha. 
Kombinace s klávesami: 
+ Shift -> uzamkne aktuální směr nebo rovinu pohybu 
+ Šipka -> uzamkne/uvolní směr vybrané osy (doleva - zelená 
osa, doprava - červená osa, nahoru/dolů - modrá osa) 
+ Číslo -> délka čáry bude rovna zadanému číslu 

Make Component 
(Komponenta)   

Slouží pro zobrazení dialogu pro vytvoření komponenty. 

Eraser 
(Guma)   

Slouží k mazání objektů, kromě ploch. Plochy lze smazat 
pomocí klávesy DELETE. 
Kombinace s klávesami: 
+ Ctrl -> vyhlazení čáry 
+ Shift -> skrytí čáry 
+ Ctrl + Shift -> zruší vyhlazení čáry 

Tape Measure Tool 
(Svinovací metr)   

Slouží k měření vzdáleností v modelu, vytváření pomocných 
konstrukčních přímek a úseček. 
Kombinace s klávesami: 
+ Ctrl -> přepnutí požadavku mezi měřením a konstrukční 
přímkou 
+ Shift -> přepnutí uzamčení směru měření do některé osy 
+ Číslo -> konstrukční přímka bude vytvořena v zadané 
vzdálenosti 

Paint Bucket 
(Plechovka barvy)   

Slouží k vyplnění plochy barvou nebo texturou. 
Kombinace s klávesami: 
+ Ctrl -> obarví i sousední shodné plochy 
+ Shift -> obarví barevně shodné plochy v celém modelu 
+ Shift + Ctrl -> převede plochu i sousedící shodnou plochu do 
základní bary 
+ Alt -> vezme vzorek s povrchu objektu 

Push/Pull 
(Tlačit/Táhnout)   

Slouží k vytažení nebo zatlačení plochy tak, že vznikne 3D 
těleso. 
Kombinace s klávesami: 
+ Ctrl -> vytažení nového objektu z plochy 
+ Číslo -> vytažení/zatlačení bude provedeno o zadanou 
vzdálenost 
Další funkce: 
Dvojitým kliknutím na plochu dojde k opakování předchozího 
vytažení/zatlačení 
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Move 
(Posun)   

Slouží k přesunu objektu, vytvoření kopie, nebo 
rovnoměrného pole. 
Kombinace s klávesami: 
+ Shift -> uzamkne aktuální směr posunu 
+ Ctrl -> přepnutí požadavku na kopii nebo přesun 
+ Alt -> přepnutí požadavku na tažení přilehlých prvků s 
přesunutým objektem 
+ Šipka -> uzamkne/uvolní směr vybrané osy (doleva - zelená 
osa, doprava - červená osa, nahoru/dolů - modrá osa) 
+ Číslo -> vzdálenost přesunu nebo kopie 

Rotate 
(Otáčení)   

Slouží k otáčení prvků, nebo jejich kopii otočením. 
Kombinace s klávesami: 
+ Shift -> uzamkne osu otáčení 
+ Ctrl -> přepnutí požadavku na kopii/otočení 

Orbit 
(Orbit)   

Slouží pro změnu pohledu. Standardně zachovává přirozenou 
orientaci vertikál. 
Kombinace s klávesami: 
+ Ctrl -> zrušení zachovávání pozice vertikál 
+ Shift -> přepnutí na funkci Posun 
Další funkce: 
Funkci lze rovněž aktivovat pomocí stlačení kolečka myši. 

Pan 
(Posun)   

Slouží k posunu pohledu. 

Zoom 
(Přiblížení)   

Slouží k přibližování a oddalování pohledu. 
Další funkce: 
Funkci lze spustit otáčením kolečkem myši. 

Zoom Extents 
(Zobrazit vše)  

 Slouží k zobrazení všech prvků v modelu. 
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3.5. UCHOPOVÁNÍ PRVKŮ 

SketchUp nabízí rozsáhlé možnosti uchopování prvků. Uchopování můžeme rozdělit na dvě části týkající se 

bodů a čar. 

3.5.1. UCHOPOVÁNÍ BODŮ 

Úchop Zvýraznění Náhled 

Endpoint 
(Koncový bod) 

zelený bod 

 

Midpoint 
(Středový bod) 

azurový bod 

 

Intersection 
(průsečík) 

červený kříž 

 

On Face 
(na ploše) 

modrý kosočtverec 

 

On Edge 
(na hraně) 

červený čtverec 

 

Half Circle 
(půlkruh) 

modrý kosočtverec 

 

Equidistant on Edge 
(Ekvidistantní na hraně) 

Purpurová čára 
spojující dva body 

na hraně 
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3.5.2. UCHOPOVÁNÍ ČAR 

Úchop Zvýraznění Náhled 

On Green Axis 
(k zelené ose) 

zelená linie 

 

On Red Axis 
(k červené ose) 

červená linie 

 

On Blue Axis 
(k modré ose) 

modrá linie 

 

From Point 
(z bodu) 

čárková linie v 
barvě příslušné osy 

 

Perpendicular 
(kolmý na hranu) 

purpurová linie 

 

Parallel 
(rovnoběžný) 

purpurová linie 

 

Tangent at vertex 
(tanganta na vrcholu) 

azurový oblouk 
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4. PŘÍPRAVA ZADÁNÍ 
K co nejrychlejšímu stanovení objemů a ploch objektu doporučujeme postupovat následovně. 

a) Vytvořit každou zónu samostatně jako komponentu. 

b) Přiřadit každé konstrukci vlastní unikátní materiál (barvu) 

c) Rozdělit jednotlivé plochy do vrstev 

4.1. VYTVOŘENÍ KOMPONENT (ZÓN) 

Po vytvoření geometrie zóny pomocí standardních funkcí je zapotřebí vytvořit pro každou zónu samostatnou 

komponentu, která umožní odečtení objemu zón. 

a) Pomocí trojkliku při zvolené funkci Select na libovolný povrch označíte všechny spojené prvky. 

 

  

Výběr všech spojených vrstev 

pomocí funkce Select a 

trojkliku na libovolnou plochu 
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b) Pomocí tlačítka Make Component (klávesová zkratka G) vyvoláte okno Create Component, ve kterém 

můžete zadat název komponenty a potvrdíte pomocí tlačítka Create. 

 

c) Nyní je vytvořena komponenta zóny, pokud chcete provádět úpravy, je zapotřebí nejprve provést 

dvojklik při funkci Select na komponentě, kterou chcete upravovat. 

 

  

Zadání názvu komponenty 

Potvrzení vytvoření 

komponenty 

Vytvořená komponenta. 

Úpravy je možné provádět po 

dvojkliku při funkci Select. 
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4.2. PŘIŘAZENÍ MATERIÁLU (BARVY) PLOCHÁM 

Přiřazení barvy plochám se provádí pomocí funkce Paint Bucket (klávesová zkratka B). 

a) Pro úspěšné přiřazení barev je potřeba být v editaci komponenty (viz bod 4.1). Následně aktivuje 

funkci Paint Bucket. Zobrazí se okno s možností výběru požadované barvy. 

 

b) Vyberte libovolné barvu a klikáním označte plochy, které budou v následném zadání aplikace 

Energetika tvořit jednu konstrukci. UPOZORNĚNÍ: V aplikaci Energetika je zapotřebí zadávat výplně 

otvorů samostatně po světových stranách. Z tohoto důvodu je potřeba barevně odlišit výplně otvorů 

podle orientace. 

 

Komponenta v režimu editace 

Okno pro výběr barvy 

Výběr palety 



Odečet ploch pomocí 3D modelu - SketchUp  

DEKSOFT  14 
 

4.3. ROZDĚLENÍ DO HLADIN 

K organizaci a vytváření hladin slouží funkce Layer (Hladina) 

Funkce Ikona Popis 

Layer 
(Hladina)  

Slouží k přiřazení prvků do hladin a jejich organizaci 

a) Otevřete Layer Manager a vytvořte hladiny, které budou reprezentovat budoucí konstrukce v aplikaci 

Energetika. UPOZORNĚNÍ: V aplikaci Energetika je zapotřebí zadávat výplně otvorů samostatně po 

světových stranách. Z tohoto důvodu je potřeba barevně odlišit výplně otvorů podle orientace. 

 

  

Ikona Layer Manager 

Okno s přehledem vrstev 

Přidání/Odebrání vrstvy 

Ovládání viditelnosti vrstvy 
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b) Všechny plochy se stejnou barvou (materiálem) můžete označit pomocí funkce Select, stisknutím 

pravého tlačítka myši na ploše a následným výběrem položky Select -> All with same Material. Výběr 

můžete vizuálně zkontrolovat (vybrané plochy jsou zvýrazněny tečkovaně). 

 

c) Vybrané plochy přiřadíte do konkrétní vrstvy výběrem z rozevíracího seznamu funkce Layer. Přiřazení 

do jednotlivých hladin lze kontrolovat pomocí zapínání a vypínání viditelnosti vrstvy. Takto přiřadíte do 

jednotlivých hladin všechny konstrukce v každé zóně. 

 

Výběr všech prvků se stejnou 

barvou (materiálem) 

Přiřazení ploch do hladiny 
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5. ODEČET OBJEMU 
Pro odečtení objemu musí být každá zóna vytvořena jako samostatná komponenta a neměla by obsahovat 

žádné vnitřní linie. Objem komponenty (zóny) lze odečíst z okna Entity Info. 

a) Pravým tlačítkem myši označte komponentu, jejíž objem potřebujete odečíst. Následně vyvolejte 

pomocí levého tlačítka myši kontextové menu a vyberte položku Entity Info. Otevře se okno s 

informacemi o prvku. 

 

b) V okně Entity Info můžete přímo odečíst objem komponenty. Okno nemusíte zavírat, stačí pouze 

postupně vybrat jednotlivé komponenty pomocí pravého tlačítka myši a v okně se zobrazí objem 

aktuálně označené komponenty. 

 

Zobrazení informací o prvku 

Objem komponenty (zóny) 

Okno Entity Info 
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6. ODEČET PLOCH 
Odečet ploch lze provést více postupy. Jeden z možných postupů je uveden v následujících bodech. 

a) Pomocí pravého tlačítka myši označte libovolnou část konstrukce, jejíž plochu chcete odečíst. 

Následně vyvolejte pro tuto plochu kontextové menu pomocí pravého tlačítka a zvolte možnost  

Area -> Layer. 

 

b) Dojde k otevření okna s údajem o celkové ploše, všech povrchů v dané vrstvě. 

 

Zobrazení plochy všech 

konstrukcí ve vrstvě vybraného 

prvku 

Plocha všech povrchů v dané 

vrstvě 
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7. VYUŽITÍ ROZŠÍŘENÍ PRO URYCHLENÍ PRÁCE 
Pro urychlení odečítání ploch lze využít i volně dostupná rozšíření, která umožňují zobrazení plochy všech vrstev 

současně. Příkladem takového rozšíření je sada nástrojů FredoTools s nástrojem Report on Areas. Tento nástroj 

je ke stažení na http://sketchucation.com/forums/viewtopic.php?f=323&t=42089#p373073. Na této adrese 

naleznete i informace k instalaci. Postup odečtu ploch pomocí tohoto nástroje je uveden v následujících 

bodech. 

a) Sada nástrojů FredoTools se spouští pomocí vlastní ikony. 

 

b) Po stisknutí ikony se zobrazí okno s výběrem požadovaného nástroje. Zvolte položku Report on Areas. 

 

Ikona FredoTools 

Nástroj Report on Areas 

http://sketchucation.com/forums/viewtopic.php?f=323&t=42089%23p373073
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c) Otevře se nové okno, ve kterém lze volit jednotky, ve kterých mají být plochy zobrazeny, zaokrouhlení 

a způsob jakým mají být plochy sčítány. Výčet ploch lze přímo exportovat do souboru ve formátu .csv. 

 

 

8. IMPORT PODKLADŮ 
V základní verzi SketchUp 8 lze importovat obrázky ve všech standardních formátech, modely ve formátu *.skp, 

formát *.3ds a další. Ve verzi 8 bohužel není možné přímo importovat *.dwg a *.dxf soubory. Tento import je 

dostupný pouze u placené verze programu.  

Import souborů *.dwg a *.dxflze provést pomocí starší verze programu SketchUp 6, která tento import 

umožňuje již v základní verzi. Případně lze použít některé z neoficiálních rozšíření, například FreeDXF Importer 

(http://sketchucation.com/pluginstore?pln=freedfx). 

9. VIDEOUKÁZKA 
Na naše webové stránky připravujeme krátké video, které názorně představí postup uvedený v tomto manuálu. 

Video naleznete v sekci PODPORA -> Technická knihovna. 

10. POZNÁMKY 
Aktuální verzi dokumentů naleznete vždy na stránkách www.stavebni-fyzika.cz v sekci PODPORA. 

Nenalezli jste v dokumentu potřebné informace? Napište nám na email info@stavebni-fyzika.cz a informace 

doplníme. 

 

Výběr jednotky Nastavení zaokrouhlení 

Výběr způsobu odečtu ploch 

Zadané vrstvy Plocha vrstev 

Export do CSV 
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